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NOTES: 
This document is provided for the own use of the operator of the NNTViewer software. 
 
QR s.r.l. reserves the right to change the contents of this manual without notice. 
 
This document may not, in whole or in part, be modified, copied, reproduced, distributed, translated, stored 
on magnetic or optical media and published, over networks, electronic bulletin boards, web sites or other on-
line services, without the express written permission of QR s.r.l. 
 
The original version of this manual has been written in english language. 
 

NNT is a registered trademark of QR s.r.l. 
All other products and brand names are registered trademarks or trademarks of their respective companies. 
 
NNT is manufactured and distributed by: 
 
QR srl 
Via Silvestrini, 20 
37135 Verona 
Italy 
Phone: ++39 045 8202727 
Fax ++39 045 8203040 
e-mail: info @qrverona.it 
www.qrverona.it 
 
All rights reserved. 
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1  About this Manual 
 

1.1  Contents 
This manual has been conceived as a mean of reference to provide information and instructions on the use 
of the NNTViewer software. 
The user shall fully read and understand this manual before using the software.  
 

1.2  Definitions 

Definition Meaning 

MAIN WORKSTATION Computer connected the CT scan. 

SECONDARY WORKSTATION 
Any computer running NNT software for the sole data processing/view. 

Thus, all the MAIN WORKSTATIONS are excluded from this 
cathegory. 

MACHINE USER MANUAL Manual dedicated to the equipment running the NNT software. 

FOV Acronym of Field Of View. 

MULTI FOV DEVICE Equipment which allows to switch to a different FOV. 

 

1.3  Structure 
This manual includes the following sections: 
 

 Chapter 1 (“About this Manual”): provides general information about the structure and the stylistic 
conventions of the manual. 

 Chapter 2 (“Getting started”): contains a general description of the machine and its main 
components. 

 Chapter 3 (“Working with a Study”): contains the description of all the tools and utilities to perform 
a secondary reconstruction and a complete analysis of the study. 

 Chapter 4 (“Working with reports”): illustrates the steps to create a report and the related utilities. 
 

 APPENDIX A: it illustrates some utilities not tackled in other chapters. 
 

1.4  Stilistic conventions 
The following table illustrates the stylistic conventions adopted by this manual: 
 

 

 
Text format 

 
Example 

 
Meaning 

 
Bold Italic 

 

File  Open… 

 
Menu or toolbar item 

 
Italic  

 
Patient File 

 
Window Title 

 
Bold Underlined 

 
Apply 

 
Button Command 

 
<text> 

 
<Demonstration template> 

 
Typed text 
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CAPITAL LETTER ENTER keyboard command 
 
 

Important safety information and notes are highlighted in the manual as follows: 
 

 

 
WARNING:  
Warns you of the presence of a potential hazard, which may cause injury or fatality. 

 

 

 
CAUTION: 
Cautions you of the presence of a potential hazard, which may cause damage to the 
equipment. 
 

 

 
NOTE: 
Draws your attention to important but non-hazardous information. 
 
 



Getting Started 
 

Rev. 1.3 – July, 30
th
 2010   Page 7 of 80 

 

2  Getting started 
 
NNTViewer is a simple version of the NNT software that doesn‟t need any installation but it is able to open 
only Study documents.  
Studies can be modified, Reports can be created and printed, but the documents cannot be saved.  
 

2.1  Software installation 
The NNTViewer software does not need any installation, it runs directly from the disk. 
 

2.2  System requirements 

 Minimum Requirement Recommended Requirement 

Processor Intel Pentium 4  ≥ 2.8 GHz or higher Intel Core 2 Duo 

Hard Drive any any 

System Memory 2 GB 3 GB 

Monitor  Video Resolution 1280x1024 and 
128MB of RAM video 

Video Resolution 1280x1024 and 
128MB of RAM video 

Additional 
devices 

CD/DVD Reader  CD/DVD Reader 

OS Windows 2000 + SP (≥4)  Windows XP + SP (≥2) 
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2.3  Main window 
The following image shows an overview of the NNTViewer software main window: 
 

 
 

A brief dexcription of each part is provided hereunder: 
 

1. Caption bar: it shows the name of the running application and information on the current document. 

2. Menu bar: it shows the available menus (they depend on the current document). 

3. Toolbar: it shows the available tools (they depend on the current document). 

4. Working area: it shows the current document. 
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3  Working with a Study 
 
NNTViewer can only work with Studies  
 

3.1  Opening a Study 

 
 

Select File->Open… 
 

 
 

On the “STUDIES LIST ” window, select the patient 
and click “OK”. 
 
Only studies on the same support than NNTViewer 
are shown 

 
Note: When NNTViewer starts, this window is 
automatically opened 
 

 

The study view will appear. 
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3.2  Study window 
Following is a brief description of the main window of the study and its different fields: 
 

 
 

1. Zoom bar: includes the buttons for the zoom management and other buttons related to the current 
view. 

 
2. Tab to swap among different views. The available views are:  

– Info   includes the scout views and the patient data.  
– Axial   includes the reconstructed axial slices. 
– MPR  allow to navigate through the reconstructed volume rotating it on the  axial plane. 
– Free cut includes the single cross sections  
– Cross  includes the sequences of cross sections 
– Panorex includes the panorex sections 
– Multiplanar includes the multiplanar sections 
– 3D  includes the 3D images 

 
3. Toolbar: contains buttons to enable various secondary reconstruction toolbars. 

 
4. First scout view: shows an image of the acquired area. 
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5. Second scout view: shows a second image (perpendicular to the first scout view) of the acquired 
area. 

 
6. Study & Exam Data: shows information about the patient, the study and the scan. 

 
Document Code: name of the document main file. 

 
Document Size: size of the entire study. 

 
Patient Scan Date: date of the scan. 

 
Document Creation Date: date of the study creation. 

 
Info images: number of scout view images. 

 
Axial images: number of axial images. 

 
Free cut sections: number of single cross sections images. 

 
Cross sections: number of sequence of cross section images. 
 
Panorex sections: number of panoramic section images 

 
Multiplanar section: number of multiplanar sections in the study. 

 
3D reconstructions: number of 3D images. 
 
Axials pitch: axial pixel size. 
 
Axials thickness: thickness of axial sections. 
 
FSV: KiloVolt and milliAmpere level used by the x-ray source for the first scout 

view. 
 
SSV: KiloVolt and milliAmpere level used by the x-ray source for the second 

scout view. 
 
FOV: scan modality.  
 
Exposure Time (s): time of exposure to the x-ray emission during the scan. 

 
mAs: product of the tube current and x-ray exposure time measured in 
seconds. 
 
Air Kerma, DAP, CTDIw, CTDIvol: Scan dose parameters. 

 
The Study is the document containing all the images renderedby the operator (Single Cross sections, 
Sequence of Cross Sections, Panoramic Section and 3D images). 
 
 
 



Working with a Study 
 

Rev. 1.3 – July, 30
th
 2010   Page 12 of 80 

 

3.3  Axial Images 

 

3.3.1  What is an axial image? 

Axial images are horizontal slices of a volume. 
The thickness of each axial depends on the thickness 
used for the reconstruction from the Volumetric data. 

 
 

 
 

3.3.2  Axial images overview. 

The following demonstrates how to display axial 
images and how to move among them. 
 
Click on the “Axial” tab. 

 
 

 
 
 
Three axial images will be displayed next to the 
lateral view. 

 
 

A blue ROI inside the lateral view shows the size of 
the reconstructed area. 
 
Three colored lines (red, green and blue) inside the 
reconstructed area indicate the location of each axial 
image currently displayed. 
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Each axial image displayed is associated with the line 
drawn on the lateral view by using the same color as 
border of the window (in this case blue). 
 
A number located in the left top corner of the axial 
image represents the position of the axial inside the 
stack of axial images. 

 

It is possible to select the number of axial slices to be 
shown in the axial view by selecting from the main 
toolbar the Show 1/2/3 axials. 

 

 
 

3.3.3  Moving among axial images. 

There are three different ways to move among the 
axial images: 
 
1. Using the sliding bar: it is located on the right 

bottom corner of the main window (see the red 
circle). Use this bar to navigate through the entire 
sequence of axial images quickly.  

 
 
2. Using the directions buttons: located on the 

main toolbar. Used to move between axial 
images: 

 

 
 

“First Image” button: displays the first axial 
image. 

 

 
 

“Previous Image” button: displays the axial 
image below the one currently selected 

 

 
 

“Next Image” button: displays the axial 
image above the one currently selected 

 

 
 

“Last Image” button: displays the last axial 
image. 

 

 

3. Double-clicking inside the lateral view: the 
axial images will reflect the position where you 
double-clicked. 
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3.4  MPR View 
The MPR view is used to display coronal, sagittal and axial sections. Following is a brief explanation of each 
type of section. 
 

 
 
 
 
 

 

Coronal Section A vertical plane 
extending from side to side that 
divides the body into front and 
back portions. 

 
 
 
 
 
 

 

Axial Section - Sections or 
“slices” on the axial plane. These 
sections are taken as horizontal 
“cuts” through the anatomy. 

 

 

Sagittal Section - An 
anteroposterior vertical plane 
passing through the body from 
front to back, dividing it in half. 

 
Three different sliding controls allow moving through each type of section. 
 
 

 
 

To switch to the MPR view, select the “MPR” 
tab. 
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Following is a brief description of the MPR view and its different fields: 

 
 
Following is a short explanation of each field: 
 

 
1. Coronal Sliding Bar: allows moving through all the coronal sections. 

 
2. Axial View: shows an axial section of the volume. 

 
3. Axial Sliding Bar: allows moving through all the axial sections. 

 
4. Coronal View: shows a coronal section of the volume. 

 
5. Sagittal Sliding Bar: allows moving through all the sagittal sections. 
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6. Sagittal View: shows a sagittal section of the volume. 
 
 

 

 
It is possible to rotate the Coronal and Sagittal axes 
on the Axial View for correcting rotations of the 
study. 
 
The three axes: Axial, Coronal and Sagittal remain 
always orthogonal.  
 
 
Using the mouse it is possible to move directly the 
axes and centers of the crosses present on the 
Axial, Coronal and Sagittal images, else, for the 
same purpose, there are the sliding bars placed 
near the Axial image. 

 
 

Using the mouse it is possible to move directly the 
axes and centers of the crosses present on the 
Axial, Coronal and Sagittal images, else, for the 
same purpose, there are the sliding bars placed 
near the Axial image. 

 

3.5  Creating new images 
Every new image is created starting from an axial image. The axial slice that is used to create a new image 
becomes the reference image view for the newly created one. 
 
Depending on the type, each image will be automatically stored under specific views (Cross sections view, 
Sequence of Cross sections view, panoramic sections view, multiplanar view, 3D images view). 
Buttons are provided to navigate through these views. 
 
The new images cannot be stored, they will be lost when the study is closed. 
 
The Secondary reconstruction toolbar provides all the commands necessary to create new images and 
modify existing images. 
 
The next sections will introduce each type of images and will explain how to create, modify and manage 
them. Each command that will be described can be deselected by pressing the ESC key on the keyboard. 
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3.5.1  Single Cross Sections 

 
 

3.5.1.1 What is a Single Cross Section? 

The Single Cross section is an image perpendicular 
to the axial plane. 
 
The height of the section is the same as the height of 
the volume. 
 

 
 

3.5.1.2 Creating a Single Cross Section. 

1. To create a new  cross section select the “Free 
cut” tab, then, using the provided sliding bar 
select the desired reference axial image. 

 
 
 

 
 

 
2. Select the Free cut setup… button from the 

toolbar on the left. 
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3. The “Analysis setup” window will appear 

 
Set the Thickness (in mm) of the single cross 
section  
 
Then press the “Save” button 
  

 
 

 
 
4. Select the New free cut section button. 
 

 
 
 

5. The cursor will change to reflect the selected 
command. 

 
6. Left click inside the axial image, at the start point 

of where the single cross section will be drawn. 
 
 
 

 
 
 
 

 
 
 
7. Drag the line to define the end point of the 

section. Using the mouse wheel it is possible 
to navigate through the axial images while 
tracing the line. 

 
8. Left (or right) click to set the end point of your 

cross section. 
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9. The new image will appear beside the axial slice 

used as reference image. 
 

 

3.5.2  Sequence of Cross Sections 

 
 

3.5.2.1 What is a Sequence of Cross Sections? 

The Sequence of Cross Sections is a series of single 
cross sections, perpendicular to a traced path. 
 
The height of each section is the same as the height 
of the volume. 
 
The width, thickness and distance between each 
section can vary. 

 
 

3.5.2.2 Creating a Sequence of Cross Sections. 

1. To create a new  sequence of cross sections 
select the “Cross” tab, then, using the provided 
sliding bar select the desired reference axial 
image. 

 

 

 
2. Select the Cross setup… button from the toolbar 

on the left side. 
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3. The “Analysis setup” window will appear allowing 
changing the parameters for the Sequence of 
Cross Sections. 
Three parameters can be set: 
 
a) Width: set the width of each transaxial image 

between 30 and 250 mm. 
 
b) Thickness: set the thickness of the cross 

section images, from 1 pixel (depending on 
the acquisition FOV) to 250 mm. 

 
c) Step: select the distance between each 

transaxial image in the sequence. 
 

Then there it to choose the tracing mode: 
with “Brocken line” the sequence will follow 
the exact traced path. 
With “Smoothed line” the cross sections will 
be calculated on a curved line which connect 
the selected points 
Using “Quick curve” the sequence is 
calculated on the curve that well interpolates 
the 5 user selected points 

 
After changing the settings click on the “Save” button. 
  

 
 

4. Select the New cross sections button.  

 
 

5. The cursor will change to reflect the selected 
command. 
Left click inside the axial image, to define the 
first point of the path of the sequence. 
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6. Drag the line and left click where you wish to 
bend your arch. Using the mouse wheel it is 
possible to navigate through the axial images 
while tracing the arch. 

 
7. Right click to set the end point of the path. 
 

 

8. The new image will appear beside the axial slice 
used as reference image. 

 

3.5.3  Panoramic Sections 

 
 

3.5.3.1 What is a Panoramic section? 

Panoramics are images perpendicular to the axial 
plane, typically showing the whole jaws (preferably 
including the TMJ), seen from directions locally 
perpendicular to the contour of the dental arch. 
 
The height of the images is the same as the height of 
the volume. 
 
The thickness and distance between each image can 
vary. 
 



Working with a Study 
 

Rev. 1.3 – July, 30
th
 2010   Page 22 of 80 

 

 
 

3.5.3.2 Creating a Panoramic Section. 

1. To create a new  panoramic select the “Panorex” 
tab, then, using the provided sliding bar select 
the desired reference axial image. 

 
 

 

 
2. Select the Panorex Setup… button ftom the 

toolbar on the left. 
 
 

 
 
 
 
 
 
 

 

3. The “Analysis setup” window will appear allowing 
changing the parameters for the Panoramic 
sections. 
Three parameters can be set: 
 
a) Number of panoramics: number of 

panoramics created by the software; one can 
choose between: 

 Single (maximum thickness = 50mm) 

 Multiple, selecting an odd number 
between 3 and 31 (maximum thickness = 
15 mm); 

 
b) Thickness: set the thickness of the images 

between the size of a Voxel and the 
maximum allowed. 

 
c) Distance: set the distance between each 

image between the size of a Voxel and 10 
mm.. 

 
d) Show pano thick highlights the panoramic 

thisckenss. 
 

e) Draw middle line (available only if the Show 
pano thick button is enabled) drawn the 
central reference of the panoramic. 

 
f) Then there it to choose the tracing mode: 

with “Brocken line” the panoramic will follow 
the exact traced path. 
With “Smoothed line” the panoramic section 
will be calculated on a curved line which 
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connect the selected points 
Using “Quick curve” the panoramic is 
calculated on the curve that well interpolates 
the 5 user selected points 

 
After changing the settings click on the “Save” button.  
 

 
 

4. Select the New panorex section(s) button. 
 

 
 

5. The cursor will change to reflect the selected 
command. 
Left click inside the axial image, to define the first 
point of the path of the panoramic section. 

 

 
 

6. Drag the line and left click where you wish to 
bend your arch. Using the mouse wheel it is 
possible to navigate through the axial images 
while tracing the arch. 

 
7. Right click to set the end point of the path. 
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8. The new image will appear beside the axial slice 
used as reference image. 

 
The panoramic images can be scrolled by playing 
with the sliding bar located between the axial and 
panoramic images or using the “+” and “-” 
buttons. 

 

3.5.4  Multiplanar images 

 
 

3.5.4.1 What are Multiplanar images? 

Multiplanar images area groups of images consisting 
of panoramic and cross sections, created 
simultaneously along the same path traced by the 
user. 
 
The height of the images is the same as the height of 
the volume. 
 
The thickness, distance and step depends on the 
stored settings for the panoramic and the cross 
section images. 
 

 
 

3.5.4.2 Creating Multiplanar images. 

1. To create a new  panoramic select the 
“Multiplanar” tab, then, using the provided 
sliding bar select the desired reference axial 
image. 
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2. From the left  bar select the Cross + Panorex 

setup… buttons  
 
 

 
 

In this case the “Analysis setup” window contains 
both the cross parameters and the panoramic ones 
(see paragraphs  3.5.2.2 and 3.5.3.2). 

 
 

3. Select the New multiplanar sectionbutton. 
 

 
 

4. The cursor will change to reflect the selected 
command. 
Left click inside the axial image, to define the first 
point of the path of the panoramic section. 
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5. Drag the line and left click where you wish to 
bend your arch. Using the mouse wheel it is 
possible to navigate through the axial images 
while tracing the arch. 

 
6. Right click to set the end point of the path. 
 

 
 

7. The new images will appear beside the axial slice 
used as reference image. 
 
Depending on the visualization status of each 
single cross section, the reference line drawn on 
the axial image could be: 
 

 Continue if the cross section is completely 
shown. 
 

 Dashed if the cross section is partially shown 
 

 Hide if the cross section is not shown. 
 
 

 
 

Vertical reference lines are drawn, using the same 
criteria of the axials, on the panoramic image to 
represent where the cross sections are located. 
These lines can be hide unchecking the options 
located under the View → Show/Hide cross 
reference on panoramic menu. 
 
For additional information about the panoramic 
images please refer to chapter  0“ 
Panoramic Sections” 
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3.5.5  3D Images 

NNTViewer IS NOT able to create three dimensional images but it is possible to show the 3D images already 
present in the study. 
 

 
 

From the toolbar select the “3D Images” button (if it is 
disabled means that there are no 3D images in the 
study)  
 

 

The 3D images will be shown near the axial slice used 
as reference image. 
 

 

3.6  Deleting existing images. 
The only images that can be deleted are Single Cross sections, sequence of cross sections, panoramic and 
3D. Lateral view and axial images cannot be deleted, since they represent the base of the study. 
 
 
 

1. Select the Tab which represents the image type 
to delete. 

 

2. From the toolbar on the left, select the “Delete 
Image(s)” button 
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3. The cursor will change to reflect the selected 
command. Left click inside the image(s) you want 
to delete. 

 
4. Right click to terminate the command. 

 

3.6.1  Deleting single cross sections from a sequence of cross sections 

It is possible to delete one or more single sections, belonging to a sequence of cross sections. 
 

 
 

1. From the “Secondary Reconstruction” toolbar, 
select the “Delete Single Image” button. 

 

2. The cursor will change to reflect the selected 
command. Left click inside the section you want 
to remove from the sequence of cross sections. 

 
3. Right click to terminate the command. 

 

3.7  Functions to extract and convert images. 

3.7.1  Extracting single cross sections from a sequence of cross sections 

Single cross sections can be created, by extracting them from a sequence of cross section. 
Three different commands are provided in order to extract single cross section from a sequence of cross 
section. 
 
 

3.7.1.1 Extract Cross Sections 

1. From the “Secondary Reconstruction” toolbar 
select the “Extract Cross Section” command. 
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2. The cursor will change to reflect the selected 
command. Left click inside the images you want 
to extract. 

 
3. Right click when you have finished. 
 

 

4. The extracted images will appear under the 
Single Cross Section view, beside the existing 
one. 

 

3.7.2  Extracting panoramic sections from a multiplanar image 

It is possible to extract the panoramic sections from a multiplanar image. 
 

 
 

1. Select the “Multiplanar” Tab. 
 

 

2. Select the multiplanar image from which you wish 
to extract the panoramic sections. 
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3. From the main toolbar select the Images 
creation toolbar command. 

 
 

4. The “Secondary Reconstruction” will appear. 
Select the “Extract Panoramic” button. 

 

5. The image will be updated showing the three 
extract panoramic sections copied into the 
panoramic view. 

 

3.7.3  Extracting sequence of cross sections from a multiplanar image 

It is possible to extract sequence of cross sections from a multiplanar image. 
 

 

1. Select the “Multiplanar” Tab. 

 
 

2. Select the multiplanar image from which you wish 
to extract the sequence of cross sections. 
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3. From the main toolbar select the Images 
creation toolbar command. 

 
 

4. The “Secondary Reconstruction” will appear. 
Select the “ Extract sequence ” button. 

 

5. The image will be updated showing the extracted 
sequence of cross sections. 

 

3.7.4  Extracting Coronal and Sagittal sections from the MPR view 

 
 

1. Select the “MPR” Tab. 
 

 
 

The MPR view will appear. For a complete 
explanation of this view please refere to chapter 0“ 
2. MPR View”. 
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3. From the main toolbar select “Images creation 
toolbar” button. 

 
 

4. The “Secondary Reconstruction” will appear. 
Select the “ Extract coronal/sagittal” button. 

 
 

5. The cursor will change to reflect the selected 
command. Click on the image (coronal or 
sagittal) you wish to extract. 

 

6. The extracted image(s) will be stored under the 
Single cross section. 

 

3.7.5  Converting a Panoramic image into a Sequence of Cross Sections. 

The software allows converting a Panoramic image line into a Sequence of Cross Sections. The settings that 
will be used to create the sequence of Cross Sections (width, thickness and step) are the ones that are 
currently saved into the Sequence of Cross Section setup window. 
 

 
 

1. Select the “Panorex” Tab. 
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2. Select the panoramic section that you wish to 
convert (you can use either the directional 
buttons located on the main toolbar or the sliding 
bar located on the bottom right corner of the 
window). 

 
 

 
 

3. From the main toolbar select “Images creation 
toolbar” button. 

 

4. The “Secondary Reconstruction” toolbar will 
appear. Select the “Panorex -> Crosses” button. 

 

5. The new Sequence of Cross Sections will be 
displayed. 

 

3.7.6  Converting a Sequence of Cross Sections into a Panoramic image. 

Another possibility is to convert a Sequence of Cross Sections into Panoramic images. The settings that will 
be used to create the Panoramic images (thickness and distance) are the ones that are currently saved into 
the Panoramic setup window. 

 1. Select the “Cross” Tab.. 
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2. Select the Sequence of Cross Sections that you 
wish to convert (you can use either the 
directional buttons located on the main toolbar or 
the sliding bar located on the bottom right corner 
of the window). 

 
 

 
 

3. From the main toolbar select “Images creation 
toolbar” button. 

 
 

4. The “Secondary Reconstruction” toolbar will 
appear. Select the “Crosses->Panorex” button 

 

5. The new Panoramic images will be displayed. 

 

3.8  Modifying an existing image. 
To modify an existing image, change its reference path on the reference axial image. 
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3.8.1  Standard drag 

The following demonstrates how to modify a panoramic image using the standard drag command. The same 
method is employed to modify Single Transaxial sections, a Sequence of Transaxial sections and 3D 
images. 
 

 
 

Select the “Panorex” Tab. 

 
 

Select the panoramic section you want to modify (you 
can use either the directional buttons located on the 
main toolbar or the sliding bar located on the bottom 
right corner of the window). 
 

 
 

Click on the “Drag” button located on the “ Images 
creation tools”. 
 

 
 

The reference path on the axial image will be 
highlighted along with yellow targets used to drag the 
path for image modification. 
 
Left click in the targets and drag the target with the 
left button depressed.  Release the button when the 
target is in the desired location.  
 
Clicking between to red targets is possible to move 
the entire curve 
 
Clicking on the yellow targets in the middle it is 
possible to stretch the curve. 
Clicking on the yellow targets in the corners it is 
possible to rotate the curve 
 
Pressing the CTRL key and moving the mouse wheel 
it is possible to enlarge/reduce the curve.  
 
Using the mouse wheel it is possible to navigate 
through the axial images while dragging the arch 
(not available for drag of single cross and 3D). 
 
To terminate the command right click. 
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A message will appear.   
 
Click on the “Modify Current Image” button to 
modify the existing panoramic image.   
 
Click on the “Create New Image” button to create a 
new image without modifying the existing image. 
 

 

The image will be automatically displayed. 

 

3.8.2  Real time drag 

The following demonstrates how to modify a panoramic image using the real drag command. The same 
method is employed to modify Single Transaxial sections, a Sequence of Transaxial sections and 3D 
images. 
 

 
 

Select the “Panorex” Tab. 

 
 

Select the panoramic section you want to modify (you 
can use either the directional buttons located on the 
main toolbar or the sliding bar located on the bottom 
right corner of the window). 
 

 
 

From the left toolbar select the the Drag (Modify) 
button. 
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The reference path on the axial image will be 
highlighted along with yellow targets used to drag the 
path for image modification. 
 
Left click in the targets and drag the target with the 
left button depressed.  Release the button when the 
target is in the desired location.  
 
Clicking between to red targets is possible to move 
the entire curve 
 
Clicking on the yellow targets in the middle it is 
possible to stretch the curve. 
Clicking on the yellow targets in the corners it is 
possible to rotate the curve 
 
Pressing the CTRL key and moving the mouse wheel 
it is possible to enlarge/reduce the curve 
 
Using the mouse wheel it is possible to navigate 
through the axial images while dragging the arch 
(not available for drag of single cross and 3D). 
 

 

In case the drag command is applied to a panoramic 
or multiplanar on the panoramic section a line with 
targets will be drawn in the middle of the image. 
 
Moving the target up and down the original traced 
path will move externally or internally of the curve. 
 
This functionality is very useful while searching for 
the mandibular canal. 

 
 

At the end right click to disable the command. 

 

3.9  Moving among different images. 
Five buttons located on the main toolbar are available to switch among different types of images. 
 
 

 
 

Info Tab: displays the scout images. 

 

 
 

Axial Tab: displays the axial images. 

 

 
 

MPR Tab: displays the MPR images. 

 

 
 

Free cut  Tab: displays the single 
cross sections images. 

 

 
 

Cross Tab: displays the seq. of cross 
section view. 

 

 

Panorex Tab: displays the panoramic 
images. 
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Multiplanar Tab: displays the 
multiplanar images.  

 

 
 

3D Tab: displays the 3D images. 

 
 
 
To move between multiple images of the same type, use the four direction buttons. These buttons are 
enabled only if you have more than one image of the same type. 
 
 
 
 

 
 

First image button: display the first image of the selected type. 

 
 

Previous image button: display the previous image of the selected type. 

 
 

Next image button: display the next image of the selected type. 

 
 

Last image button: display the last image of the selected type. 

 

3.10  Modifying image appearance. 

3.10.1  Visualization window 

The visualization window allows selecting the tissues to display on the image depending on their density (it 
modifies the relation between the 256 levels of gray that can be visualized and the values of the single pixels 
of the image). It also allows adjusting the filter that can be applied to the images.  
 
 
 
 
 

 
 

1. The “Visualization Window” can be open in two 
different ways: 

 

 Doubleclicking on the image you wish to 
modify (for the scout view, doubleclicking 
outside the ROI area). 

 

 Selecting the “ Change the image palette” 
button from the main toolbar. 
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2. If the window has been open using the toolbar 
button, the “Select Image Group” window will 
appear. This window prompts to select the type 
of image that will be used, as sample, during the 
process of adjustment of the tissues. 

 
3. Select the type of image you wish to use. 

 

4. The “Visualization Window” will appear. 
 

A preview image allows to instantly verify how 
the modifications apply to the image. 
 
On the right of the preview image a sliding bar 
allows moving through all the images of the 
selected type. 
 
On the left of the preview image the filter‟s 
sliding bar is located. Using this bar is possible 
to modify the settings of the filter that will be 
applied to the image 
 
 

 

To modify the settings, move the cursor over the 
arrows beside the gray scale below the preview 
image. 
Left click and drag the arrow with the left button 
depressed. Release the button when the arrow 
is in the desired position. 
 
The color options located on the right of the gray 
level sliding bar allow to select the image tone. 
Available tones are: Gray, Sepia, Blu Film, 
Red, Flame e Spectrum,( this last one not 
available for old exam). 
 
The button located between the gray scakle and 
the tone options, inverts the image colors. 

 
 

 

On the left of the gray level bar three vertical 
sliding bars are located: 
 

- Gamma: Allows to change the relation 
between the selected Min and Max value from 
linear to nonlinear (increasing/decreasing the 
bright levels or the dark level gamma).. 

 
- BErh (not available on old exam): filter that 

enhances the hard tissues, improving the 
contrast with the soft tissues;. 

 
- STS (not available on old exam): filter that 

smooth the soft tissues 
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It is possible to customize and save three 
predefined levels for the gray scale and the filter. 
To do that: 
 

a) Click one of “Wnd1”, “Wnd2” or “Wnd3” 
buttons. The  “Record” button will 
appear. 

b) Modify the gray scale window. 
c) Click on the “Record” button. 

 
You will be able to use the stored windows 
settings later by clicking on the corresponding 
“Wnd” button. 

 
NOTE: before a new document is created the 
Wnd1 is set for default. 

  
5. Once you are satisfied with your settings select 

the “Apply” button. 
 

 

6. The “Apply To” window will appear. 
 
Select how you want to apply your changes. 
Three options are available: 
 
a) Current Image: changes will be applied only 

to the selected image. 
b) Current Image Group: changes will be 

applied only to the images belonging to the 
selected image group (Single Cross Section, 
Pano, 3D etc…) 

c) All images: (could be disabled) changes will 
be applied to all the images of the study. 

 
(Selecting this options a short messagge will 
appear, stating that the filter will not be applied 
to any image and the palette will not be applied 
to the 3D and Scout images). 

 
7. Once chosen click on the “OK” button. 

 

3.10.2  Modifying the zoom 

 
 

On the right side of the main window, the zoom 
toolbar is located. 
 
This toolbar includes five predefined zoom values 
buttons and a sliding bar to obtain customizable 
zoom levels. 
 
The five predefined zoom buttons are: 
- Stretched the images are stretched to fill the 

available area,  
- 100% 1cm on the image is 1cm on the screen 
- 75%,  
- 50%  
- None it is used 1 screen pixel for each image 

pixel. 
 
The customizable zoom level can vary from 15% to 
400%. 
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Selecting the “Setup Zoom” a dialog box will appear 
in which is possible to customize either the value of 
the three custom zoom buttons and the zoom initial 
value applied after to a brand new study. 

 

3.11  Managing images. 
For every image (Cross Section, Sequence of Cross Sections, Panoramics and 3D) is possible to control the 
way the images are displayed including the number of the visualized images and the zoom of these images. 
 

 
 

 
In the toolbar on the left of the window there is an area 
reserved to manage the images. 
Depending on the image type the tool‟s number  could 
change. 

 
 

A horizontal sliding bar allows changing the zoom of the 
reference axial image in relation to the zoom of the 
secondary image (Single Cross Section, Sequence of 
Cross Sections, Panoramic, 3D) 
 
Below the sliding bar a section is reserved to set the 
number of images to display in a single row (columns) 
and the number of rows to show. 
 
Use the two buttons (+/-) to increase/decrease each 
value.  

 

3.12  Hiding the images overlays 
The image overlays are all the graphic objects (lines, arrows, distances, angles, text, profiles, markers etc…) 
that can be manually added to the images. A command is provided in order to temporarily hide these 
objects, and show the images in their original status. 
 
 

 
 
 

 
From the main toolbar of the study select the 
“Show/hide image overlays” command. 
Deselect the command to restore the visualization of 
the overlay. 

 

3.13  Saving images in different file formats 
Each image can be saved in a JPEG or BMP format. To save an image follow these steps: 
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Select File →Save Image As…  

 
 

The cursor will change its appearance to reflect 
the selected command. 
 
Left click on the image you wish to save. 

 
 

The “Save As” window will appear with a 
suggested file name. 
 
Browse for the directory where you want to save 
the file. 
 
From the “Save As Type”  list select the file format 
in which you wish to save the image. 
 
Click on the “Save” button to save the file. 
 
 

 Once the file has been saved, the “Save image 
as…” command is still active. To deactivate it right 
click. 
 
NOTE: The  “Save image as…” comand is 
available also for the RawData and Volumetric 
Data. 

 

3.13.1  Screen shot command 

 
 

1. From the main toolbar select the Screen 
shot….button 

 

 
 

2. The cursor will change to reflect the selected 
command. Select the screen you wish to grab, then 
left click on it. 



Working with a Study 
 

Rev. 1.3 – July, 30
th
 2010   Page 43 of 80 

 

 
 

3. The “Save As” window will appear with a suggested 
file name. 

 
Browse for the directory where you want to save the 
file. 

 
From the “Save As Type”  list select the file format in 
which you wish to save the image. 

 
Click on the “Save” button to save the file. 

 

 Once the file has been saved, the “Save image as…” 
command is still active. To deactivate it right click. 

 

3.14  Exporting the axial images in DICOM format 
The DICOM (Digital Image and Communication in Medicine) is the file format that aid the distribution and the 
viewing of medical images. The Newtom software allows to export and subsequently import the axial slices 
in DICOM format. 
 

Note: 
The pixel’s value of the created images do not have any Hounsfield scale correspondence. 

 

3.14.1  Exporting the axial images in DICOM format 

 
 

After a study has been opened, select File → 
Save axial images in DICOM format. 
 
To start the exportation select Free matrix to 
export the image keeping its original pixel size or 
512x512 Matrix to force image dimensions to a 
512x512 pixel matrix, this format is obtained 
reducing, if necessary, the original axial images. 
 

 
 

The “Browse for folder” window will appear. 
Browse for the folder in which you want to export 
the DICOM images, then select the “OK” button. 
 
NOTE: in the selected folder, another one will be 
created, named ..\Surname_Name_YYYYMMDD, 
containing the DICOM images. 



Working with a Study 
 

Rev. 1.3 – July, 30
th
 2010   Page 44 of 80 

 

 
  

The export process will start. 

 

3.15  Working with toolbars 
Lines, distances, angles, markers, text and profiles can be added to all images. 
For the 3D images, only lines and text can be added. 
This chapter will show how to apply these overlays to the images. 
 

3.15.1  Images creation toolbar 

 
 

From the main toolbar select the “Images creation 
Toolbar” menu. 

 
 

The “Images creation toolbar” will appear. 
All the included command are fully described in chapters  
3.5  “Creating new images”, 
3.6  “Deleting existing images.”, 
3.7  “Functions to extract and convert images.” and 
3.8  “Modifying an existing image.”. 

 

3.15.2  Working with angles 

 
 

Click on the “Angles Toolbar” button. 

 
 

The “Angles toolbar” will appear. 

 
 

3.15.2.1 Adding a new angle 

1. Click on the “New Angle” button 
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2. The mouse cursor will change into a blue, 90 degrees 
angle.  Left click in the image to place the angle. 

 

 
 

3. When the angle is placed, yellow targets will be 
displayed to move the extremities of the angle and the 
angle‟s label. 

 

 
 

4. Left click in the targets to open or close the angle, 
with the left button depressed 

 

 
 

5. Release the left button of the mouse when the angle 
is in the desired location. 

 
6. Right click to terminate the command 

 
 

3.15.2.2 Modify an angle 

1. Click on the “Drag” button 
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2. Yellow targets will be displayed to move the 
extremities of the angle and the angle‟s label. 

 
 

3. Left click in the targets to open or close the angle, 
keeping the left button of the mouse depressed. 

 
4. Release the left button of the mouse when the targets 

are in the desired location. 

 
 

5. The label of the angle can be positioned by left 
clicking in it and moving the mouse. 

 
6. To terminate the command, right click 

 
 

3.15.2.3 Delete an angle 

1. Click on the “Delete One Angle” button 
 

 
 

2. A yellow border will highlight the label of the angle. 
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3. Left click inside the label to delete a specific angle. 
 
4. Right click to finish. 

 
 

3.15.2.4 Delete all angles 

1. Click on the “Delete All Angles” button 
 

 

2. Left click on the image where you want to remove all 
the angles. 

 
3. Right click to finish the command. 

 

3.15.3  Working with lines and arrows 

 
 

Click on the “Lines Toolbar” button. 

 
 

The “Lines toolbar” will appear. 

 
 

3.15.3.1 Trace a new line 

1. Click on the “New Line” button. 
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2. Left click in the image at the start point of the 
distance. 

 
 

3. Drag the line and left (or right) click at the end point of 
the distance.  

 
4. To terminate the command, right click. 

 
 

3.15.3.2 Trace a new line with text 

1. Click on the “New Line + Text” button. 
 

 
 

2. The “Text Editor” window will appear. Edit the text you 
wish to insert next to the line, then click on the “OK” 
button. 

 

 
 

3. Left click in the image at the start point of the 
distance. 

 
4. Drag the line and left (or right) click at the end point of 

the distance.  
 
5. Drag the text and left (or right) click in order to fix it. 
 
6. To terminate the command, right click. 

 

3.15.3.3 Trace a new arrow 
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1. Click on the “New Arrow” button. 

 
 

2. Left click in the image where you want your arrow to 
point. 

 
 

3. Drag the arrow and left (or right) click at the end point 
of the arrow. 

 
4. To terminate the command, right click. 

 
 

3.15.3.4 Trace a new arrow with text 

1. Click on the “New Arrow + Text” button. 
 

 
 

2. The “Text Editor” window will appear. Edit the text you 
wish to insert next to the line, then click on the “OK” 
button. 

 

 
 

3. Left click in the image at the start point of the 
distance. 

 
4. Drag the line and left (or right) click at the end point of 

the distance.  
 
5. Drag the text and left (or right) click in order to fix it. 
 
6. To terminate the command, right click. 
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3.15.3.5 Modify a line or an arrow 

1. Click on the “Drag” button. 
 

 
 

2. Yellow target squares will be displayed to drag the 
line.  Left click in the target and move the mouse with 
the left mouse button depressed. The line color will 
become purple. 

 
 

3. Release the button when the line is at the desired 
location. 

 
4. To terminate the command, right click. 
 
NOTE: In case a text has been inserted together with the 
line or arrow it will be possible to modify it by using the 
text toolbar. 

 
 

3.15.3.6 Deleting lines/arrows one at a time 

1. Click on the “Delete One Line” button. 

 
 

2. Yellow target squares will be displayed in order to 
select the line to delete. 
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3. Left click in the target to delete the selected line. 
 
4. To terminate the command, right click. 
 
NOTE: In case a text has been inserted together with the 
line or arrow it will be possible to remove it by using the 
text toolbar. 

 
 

3.15.3.7 Deleting all lines and arrows 

1. Click on the “Delete all lines” button. 

 
 

2. Left click inside the image where you want to remove 
all the lines and/or arrows. 

 
3. Right click to finish the command. 
 
NOTE: In case a text has been inserted together with the 
line or arrow it will be possible to remove it by using the 
text toolbar. 

 

3.15.4  Working with distances 

 

 
 

Click on the “Distances Toolbar” button. 

 
 

The “Distances toolbar” will appear. 

 
 

3.15.4.1 Trace a new distance with hyphen and arrow 

1. Click on the “New Distance (arrow + hyphen)” 
button. 
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2. Left click in the image at the start point of the 
distance. 

 
3. Drag the line and left (or right) click at the end point of 

the distance. 
 
NOTE: In case the “Label auto positioning” flag (displayed 
in the “Graphic Options” window when the Distances 
group is enabled) is unckeched, after the distance has 
been traced you will be prompted to position the label by 
dragging it and left clicking with the mouse. 
 
4. To terminate the command, right click. 

 
 

3.15.4.2 Modify a distance 

1. Click on the “Drag” button. 

 
 

2. Yellow target squares will be displayed to drag the 
distance.  The label of the distance can also be 
moved.  Left click in the target and move the mouse 
with the left mouse button depressed. The line color 
will become purple. 

 

 
 

3. Release the button when the distance is at the 
desired location. 

 

 
 

4. Left click in the label and move it with the left mouse 
button depressed. The label background will become 
purple. 

 
5. Release the button when the label is at the desired 

location 
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6. To terminate the command, right click. 

 
 

3.15.4.3 Delete a distance 

1. Click on the “Delete One Distance” button. 
 

 
 

2. A yellow target square will be displayed on the 
distance label to select the distance to delete. 

 

 
 

3. Left click in the target to delete the selected distance. 
 
4. To terminate the command, right click. 

 
 

3.15.4.4 Delete all distances 

1. Click on the “Delete all distances” button. 
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2. Left click inside the image where you want to remove 
all the distances. 

 
3. Right click to finish the command. 
 

 

3.15.5  Working with 3D distances 

 
 

 
Click on the “3D Distances Toolbar” button. 

 
 

The “3DDistance toolbar” will appear. 

 
 

3.15.5.1 Trace a new 3D distance 

1. Click on the “New 3D Distance” button. 
 

 
 

2. Left click inside the axial image to set the start point of 
the 3D measurement.  A white cross will be displayed. 

 

 

3. Move between the axial images with the direction 
buttons and select the axial image to set the end point 
of the measurements. 
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4. Left (or right) click. The distance will be displayed on 
all the axial images within the measurement. 

 
5. Right click again to terminate the command. 

 
 

3.15.5.2 Modify a 3D distance 

1. Click on the “Drag” button. 
 

 

2. Move between the axial images with the direction 
buttons and select the axial image containing the start 
or end point of the 3D measurements. 

 

 
 

3. Yellow targets will be displayed to move the 
measurements and the label.  Left click in the target 
and move them with the left mouse button depressed. 

 

 
 

4. Release the button when the measurement is in the 
desired location. 

 
5. To terminate the command right click. 

 
 

3.15.5.3 Delete a 3D distance 

1. Click on the “Delete 3D Distance” button. 
 



Working with a Study 
 

Rev. 1.3 – July, 30
th
 2010   Page 56 of 80 

 

 
 

2. The label of the measurement will be highlighted with 
a yellow border. 

 

 
 

3. Left click inside a label to delete a distance. 
 
4. When finished right click. 
 

 
 

3.15.5.4 Delete all 3D distances 

1. Click on the “Delete all 3D Distances” button. 
 
 

 

2. You will be prompted to confirm before deleting all 3D 
measurements from the selected image. 

 
3. Click “Yes” to delete all the 3D measurements 
 

 

3.15.6  Working with markers 

The marker is a graphic object that can be traced on axial, cross section and panoramic images (having a 
thickness lower than 1 mm). Once the marker has been traced it will be reported on all the images that cross 
its path (with the exception of 3D images). 
 
The typical usage of the marker is highlighting the path of the mandibular canal in the panoramic image, and 
recognize its position in the cross sections. 
 
 Click on the “Markers Toolbar” button. 
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The “Markers  toolbar” will appear. 

 
 

3.15.6.1 Trace a small marker 

1. Click on the “New Small Marker” button. 
 

 
 

2. Trace the path of the marker left clicking while moving 
the mouse. 

 
3. To terminate the command right click. 

 
 

3.15.6.2 Trace a medium marker 

1. Click on the “New Medium Marker” button 
 

 
 

2. Trace the path of the marker left clicking while moving 
the mouse. 

 
3. To terminate the command right click. 

 
 

3.15.6.3 Trace a large marker 

1. Click on the “New Large Marker” button. 
 

 
 

2. Trace the path of the marker left clicking while moving 
the mouse. 

 
3. To terminate the command right click. 
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3.15.6.4 Change the marker color 

1. Click on the “Change Default Marker color”button. 
 
2. The “Color” window will open. Select the desired color 

for the marker and click on the “OK” button. 
 

 
 

3.15.6.5 Hide all the markers in the study 

3. Click on the “Hide All Markers” button. 
 
4. All the markers in the study will be hidden (to restore 

the markers after they have been hidden, click again 
on the “Hide All Markers” button). 

 
 

3.15.6.6 Delete a marker 

1. Click on the “Delete Marker” button. 
 
2. Select the marker to be deleted. 

 
 

3.15.6.7 Delete all the markers from the study 

1. Click on the “Delete All Markers” button. 
 

 

2. You will be prompted to confirm before deleting all the 
markers from the study. Select the “Yes” button. 

 
3. All the markers will be removed from the study (Use 

this command with caution!). 

 

3.15.7   Working with profiles 

A profile reports the value of each data point of an image on a scale from 0-65535. 
 

 
 

Click on the “Profile Toolbar” button. 

 
 

The “Profile toolbar” will appear. 

 
 

3.15.7.1 Apply a profile 

1. Click on the “New Profile” button. 
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2. Left click inside an image, drag the line and left (or 
right) click. 

 
 

 
 

3. A window with the profile will appear. The red dot 
represents the highest gray level point of the profile. 
The green dot represents the lowest gray level point 
of the profile. 
Click on the “Apply” button 
 
 
To amplify the graphic scale, click on “Stretch” 
button as showed in figure. 

 
 

4. The profile will be inserted in the image. 

 
 

3.15.7.2 Increase the zoom of a profile 

1. Click on the “Zoom+” button. 
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2. Left click inside the image where you have applied the 
profile. 
The graph of the profile will increase its size. 

 
3. Right click to terminate the command. 

 
 

3.15.7.3 Decrease the zoom of a profile 

1. Click on the “Zoom-” button. 
 

 
 

2. Left click inside the image where you have applied the 
profile. 
The graph of the profile will decrease its size. 

 
3. Right click to terminate the command. 

 
 

3.15.7.4 Delete a profile 

1. Click on the “Delete Profile” button. 
 

 

2. Left click inside the image where you want to delete 
the profile. 

 
3. The profile will be removed from the image. 

 

3.15.8  Working with text 

Text can be apply to all the images in different ways 
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Click on the “Text Toolbar” button. 

 
 

The “Text toolbar” will appear. 

 
 

3.15.8.1 Apply a single line of text 

1. Click on the “Single line string” button. 
 

 
 

2. The “Text editor” window will appear. Type your text. 
You can choose the font style, size and color. 

 
3. Once you have finished click on the “OK” button. 
 

 
 

4. The text you have just entered will be show near to 
the mouse cursor. Move the mouse and left click to 
place the text in position. 
If you wish to paste again the same text left click 
another time. 

 
5. Mouse-right click when finished. 
 
Note: if the text you are inserting is a number (f.e.: 35) 
or is a text that finsh with a number (f.e.: Root of 16), 
by using mouse-wheel before to place text on the 
image, is possible to change the number value. 

 
 

3.15.8.2 Edit text and font size of an existing text 

1. Click on the “Edit text and size” button. 
 

 2. The text in the window will be highlighted. 
 
3. Left click inside the text box. 
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4. The “Text Editor” window will appear. You can modify 
font style, size and color. 

 

 
 

5. Once you have completed your changes, click on the 
“OK” button. 

 

 
 

6. The modified text will appear highlighted. Use the 
mouse to change the size and the position of the box 
that contains the text. 

 

 
 

7. Right click to apply the changes. 

 
 3.15.8.3 Moving text 
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1. Click on the “Drag text” button. 
 
 

 
 

2. The text will appear highlighted. Use the mouse to 
change the size and the position of the box that 
contains the text. 

 

 
 

3. Once you have moved the text right click to close the 
command. 

 
 

3.15.8.4 Delete a line of text 

1. Click on the “Delete one text” button. 
 
 

 
 

2. A blue box will appear around each text. 
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3. Move the cursor over the text to highlight it and then 
left click to delete it. 

 
 

3.15.8.5 Delete all the text from an image 

1. Click on the “Delete all texts” button. 
 
 

 

2. Left click over the image from which you want to 
delete all the text. 

 
3. Right click to deselect the command. 
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3.15.9  Tools toolbar 

 

The “Tools” toolbar is located on the right side of the 
study window. It includes most of the commands that can 
be found in the single toolbars. 
 
Each toolbar is identify by a specific button that , if 
pressed, expand the command of the selected toolbar 
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4  Working with reports 
 

4.1  Creating a new report 
A study must be open and images must be available from that study in order to create a report. 
 

4.1.1  Open a template 

 
 

After opening a study select Report -> 
New… 

 
 

The “Open Report Page Layout” window will 
appear displaying all of the templates. 
 
Select a template from the list and click on 
the “OK” button. 
 

 
 

The “Report Page Layout” window will 
appear. 
 
It is possible to modify the template layout at 
this time before using it.  
 
At the end click on the “OK” button. 
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The template will be placed beside the 
images of the study and the “Report Page 
Layout” will reappear. Select a new template 
and click the “Ok” button if you wish to add 
anew page to the report, otherwise press the 
“Cancel” button. 
 

1 2

3

4

 
 

 
1. Header 
2. Patient data 
3. Empty image fields 
4. Comment field 
 
Note the patient data (name, birth date and 
scan date) and header are automatically 
displayed in the template. 
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4.1.2  Add images to the report 

 
 

Left click in the image field on the template. 
The field color will become yellow. 
 

 
 

Left click on an image. 
 
If the image is too large to fit in the selected 
field, a green „Report Field Frame‟ will be 
displayed on the image. 
 
Adjust the frame location by placing the icon 
(a hand with extended index finger) 
anywhere on the green line and moving the 
mouse. 
 
Right click after you have moved the field 
frame to the desired position. 
 

 
 

The image will be copied into the report. 
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Move between different types of images 
repeating the previous step to insert 
additional images in the report. 
 
In this example we are inserting a two 
panoramic images, a few transaxial sections. 

 
 

 
…and a frontal 3D image. 

 
 

At the end the report will be completely full.  
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4.1.3  Automated images insertion 

The insertion of images in a report can be optimized using the automated modality. This modality allows  
selecting sequentially the images to copy inside the report without highlighting the report boxes every time. 
Following is a brief description of this working modality. 
 

 

Open an empty report page. 
 

 Keeping the F1 button pressed, select an 
image that has to be inserted in the report, 
repeat this operation for all the images have 
to be inserted. 
 

 
 

If the position of the images has to be known 
in advance, select “Report → Report 
Wizard”  
 

 

The boxes inside the report page will be 
identified by numbers. 
 
At the same time the first box will be 
automatically highlighted. 
 
Select the image you wish to insert in the 
first box. 
 
After the image hasbeen copied inside the 
report, the following box will be highlighted.  
 
Proceed in the same way until all the boxes 
have been filled. 
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4.1.4  Delete images from a report 

 
 

To delete an image from the report, right 
click on the image in the report. 
 
A pop-up menu will appear.  
 
Click on the “Remove” menu item. 
 

 
 

A red cross will be drawn on the selected 
image. 
 

 

You will be prompted to confirm before 
deleting the image.  
 
Click on Yes to delete the image. 
 

 

4.1.5  Insert notes in the report 

 
 

Be sure a note field has been designated 
within the report. 
 
Left click on the report to enable it. 
 
Select Edit -> Report Page Notes… 
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The “Text editor” window will appear. 
 

 
 

 
Type the notes and format the text as you 
wish. 
 
It is possible to change font type, size, style 
and color. 
 
When you have finished select the “OK” 
button. 

 
 

The notes will appear on the report page. 
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4.1.6  Remove notes from the report 

 

To remove the notes from a report select 
Edit -> Empty Report Notes… 
 
NOTE: In case the report is made of more 
than one page you will be prompted to select 
the page from which you wish to remove the 
notes. 

 

4.1.7  Adding new pages to a report 

 
 

To add new pages to the report, click on 
Edit -> Add report page… 
 

 
 

The “Open Report Page Layout” window will 
appear displaying all the available templates. 
Select a template to insert new report page 
into and click on the “OK” button. 
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The “Report Page Layout” window will 
appear. 
 
It is possible to modify the template layout at 
this time before using it.  These 
modifications will only apply to this study‟s 
report and not to the template itself. 
 
Click on the “OK” button. 
 

 

A new empty page will appear below the first 
one. 
In the “Open Report Page Layout” click the 
“Cancel” button to start inserting images into 
the new page, or select another template 
and press the “Ok” button to add another 
page to the report 
 
 
A report can contain up to xx pages. 

 

4.1.8  Removing pages from a report 

 
 

If the report has more than one page, it is 
possible to delete pages. 
 
To select the page to remove, left click on 
the page‟s title bar. 
 
Click on Edit - > Remove Report Page… 
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The “Select report page” window will appear. 
 
From the drop down list select the page you 
want to remove. 

 

You will be prompted to confirm before 
removing the page from the report. 
 
Click on the “Yes” button to remove the 
page. 
 

 

4.2  Advanced report functions 

4.2.1  Modifying the template of a report page. 

 
 

Click on Edit - > Report Page Layout… 
 
 

 

If the report contains more than one page 
you will be prompted to choose the page you 
wish to modify the layout. 
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The “Report Page Properties” window will 
appear. 
 
If images have already been copied into the 
page, it is only possible to change the 
placement of the images in order to keep the 
1:1 scale. 
 
If no image has been placed in a report‟s 
field, it is possible to modify both the size 
and the position of the field. 
 
Make changes in the same manner as 
creating a new template.  
 
After making changes, click on the “OK” 
button. 
The existing report will be automatically 
updated. 

 

4.2.2  Modifying the appearance of the report images 

It is possible to modify the gray levels of an image already copied into a report. 
 

 
 

Move the cursor over an image of the report 
and right click.  
A pop-up menu will appear. Select the 
“Change Palette…” menu. 

 

The “Visualization Window” will appear, 
showing a preview of the selected image. 
 
For a detailed explanation of this dialog refer 
to 3.10.1 “Visualization window”. 
 
Once you are satisfied with your settings 
select the “Apply” button. 
 

 

4.2.3  Use of the “Draw Only On Reference Image” menu item. 

 

The “Draw Only On Reference Image” flag 
appears in the pop-up menu after right clicking 
on an image in the report. 
 
If the flag is checked (default) the selected 
image will display its reference lines only inside 
the axial image from which it has been created 
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(reference image). 
 
Otherwise, (item not checked) reference lines 
will be drawn on all of the axial images of the 
report. 
 

 
 

 
 
 
 
 
 Esempio di immagine assiale senza linee di 
riferimento 

 

 
 
 
 
 Esempio di immagine assiale con linee di 
riferimento 
 
 
 

 

4.2.4  Use of the “Highlight crosses on panoramics” menu item  

 
 

The “Highlight crosses on panoramics” flag appears in 
the pop-up menu after right clicking on a single transaxial 
or sequence of transaxial images in a report. 
 
If checked, each transaxial view will draw a complete 
reference line on each panoramic image, otherwise, 
(default condition) only a partial reference will be 
displayed at the bottom of the panoramic images.  
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Alla prima selezione del comando si ottengono riferimenti 
completi 
 
 
 Panoramica con linee di riferimento delle transassiali 
complete 

 
 

 
 
Alla seconda selezione del comando le linee verranno 
solo parzialmente colorate 
 
 
 Panoramica con linee di riferimento delle transassiali 
parziali 

 

 
 
Alla terza selezione il comando viene disabilitato e 
verranno disegnati solo i riferimenti minimi. 
 
 
 
 Panoramica con linee di riferimento delle transassiali 
minime (solo in basso) 

 

4.2.5   Performing measures of distances or angles  

On the images of the report it is possible to perform measures of distances or angle as it is done on the 
images of the study. (see chapter 3.15 “Working with toolbars“). 
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Move the cursor over an image of the report 
and right click.  
 
A pop-up menu will appear. Select the 
“Distances…” to show the menu about 
measures of distances. 
Select the “Angles…” to show the menu 
about measures of angles. 

 

4.3  Printing a report 

 

To print a report select File -> Print… 
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5  Appendix A 
 

5.1  Closing the software 

Close the NNTViewer application by clicking on File  Exit from the main window. 
 

 


	NNT is manufactured and distributed by:
	1  About this Manual
	1.1  Contents
	1.2  Definitions
	1.3  Structure
	1.4  Stilistic conventions

	2  Getting started
	2.1  Software installation
	2.2  System requirements
	2.3   Main window

	3  Working with a Study
	3.1  Opening a Study
	3.2   Study window

	Document Code: name of the document main file.
	Document Size: size of the entire study.
	Patient Scan Date: date of the scan.
	Document Creation Date: date of the study creation.
	Info images: number of scout view images.
	Axial images: number of axial images.
	Free cut sections: number of single cross sections images.
	Cross sections: number of sequence of cross section images.
	Panorex sections: number of panoramic section images
	Multiplanar section: number of multiplanar sections in the study.
	3D reconstructions: number of 3D images.  Axials pitch: axial pixel size.
	Axials thickness: thickness of axial sections.
	FOV: scan modality.
	Exposure Time (s): time of exposure to the x-ray emission during the scan.
	3.3   Axial Images
	3.4  MPR View

	Three different sliding controls allow moving through each type of section.
	3.5  Creating new images

	The new images cannot be stored, they will be lost when the study is closed.
	The next sections will introduce each type of images and will explain how to create, modify and manage them. Each command that will be described can be deselected by pressing the ESC key on the keyboard.
	3.5.1  Single Cross Sections
	3.5.2  Sequence of Cross Sections
	3.5.3  Panoramic Sections
	3.5.4  Multiplanar images
	3.5.5   3D Images
	3.6  Deleting existing images.
	3.6.1  Deleting single cross sections from a sequence of cross sections

	3.7  Functions to extract and convert images.
	3.7.1  Extracting single cross sections from a sequence of cross sections
	3.7.2  Extracting panoramic sections from a multiplanar image
	3.7.3  Extracting sequence of cross sections from a multiplanar image
	3.7.4  Extracting Coronal and Sagittal sections from the MPR view
	3.7.5  Converting a Panoramic image into a Sequence of Cross Sections.
	3.7.6  Converting a Sequence of Cross Sections into a Panoramic image.

	3.8  Modifying an existing image.
	3.8.1  Standard drag
	3.8.2  Real time drag

	3.9  Moving among different images.
	3.10  Modifying image appearance.
	3.10.1  Visualization window
	3.10.2  Modifying the zoom

	3.11  Managing images.
	3.12  Hiding the images overlays
	3.13  Saving images in different file formats
	3.13.1  Screen shot command

	3.14  Exporting the axial images in DICOM format
	3.14.1  Exporting the axial images in DICOM format

	3.15  Working with toolbars
	3.15.1  Images creation toolbar
	3.15.2  Working with angles
	3.15.3  Working with lines and arrows
	3.15.4  Working with distances
	3.15.5  Working with 3D distances
	3.15.6  Working with markers
	3.15.7   Working with profiles
	3.15.8  Working with text
	3.15.9  Tools toolbar


	4  Working with reports
	4.1  Creating a new report
	4.1.1  Open a template
	4.1.2  Add images to the report
	4.1.3   Automated images insertion
	4.1.4  Delete images from a report
	4.1.5  Insert notes in the report
	4.1.6  Remove notes from the report
	4.1.7  Adding new pages to a report
	4.1.8  Removing pages from a report

	4.2  Advanced report functions
	4.2.1  Modifying the template of a report page.
	4.2.2  Modifying the appearance of the report images
	4.2.3  Use of the “Draw Only On Reference Image” menu item.
	4.2.4  Use of the “Highlight crosses on panoramics” menu item
	4.2.5   Performing measures of distances or angles

	4.3  Printing a report

	5  Appendix A
	5.1  Closing the software


